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SCOPE OF THE GUARD TOUR FEATURE 
The current Guard Tour feature described herein is compatible with any version of SG 10.  This guide was last 
updated for the SG 10.4 Release due to minor enhancements of the tour features. 

The Guard Tour feature is designed to track and report the real-time movement of security guards/safety officers 
as they make their security rounds within a facility, by activating tour checkpoints.  The system applies various 
timers and rules that are used to help the SG Guard Tour Operators to monitor the tours as they are in progress.   

The Guard Tour itself does not impact the hardware programming; although it relies on the operation of 
credentials, readers and inputs that have been configured and loaded to the control panels.  

SUPPORTING  MANUALS 
This guide covers Guard Tour programming.  See the supporting manuals for instructions outside the scope of this 
addendum. 

• See the 635/600 Hardware manual for instructions on normal installation of the control panels (i.e.
controllers), readers and input devices.

• See the System Galaxy User Guide (software manual) for instructions on configuring the behavior of the
hardware (loops, control panels, readers and inputs) and how to load the configuration to the control
panels

• See the System Galaxy User Guide (software manual) for extended instructions on enrolling cards or
creating schedules and access groups, assigning personal doors, as well as loading data to the control
panels.

UPDATE HISTORY OF THIS ADDENDUM 

DATE HISTORY OF CHANGES 

2013 Addendum created from instructions excerpted from the Software Guide chapter 13. 

2014 Addendum received major overhaul of existing features and new features/functionality. 

10/14/2014 Expanded requirements, added step to card enrollment concerning PIN, a formatting repair. 

JUN 2017 Update Cover 10.5.1 Release 

JUN 2016 Update Cover 10.5.6 Release 
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System Requirements of the Guard Tour feature:  

• The Guard Tour feature must be registered (enabled) in the System Galaxy system registration before it 
can be configured for operation.   

• Tour Alarms are reported to the SG Alarm event screens (system-wide) by default.  To control or suppress 
which clients will see the Alarm events, the Alarm Priority and Guard Tour Alarm priorities must be 
programmed.  

• The startpoint of every tour must be a reader. If a Tour start reader is shared with multiple tours (assigned 
to more than one tour), the reader must be a keypad combo reader and must be configured properly. 

• Inputs can be assigned as checkpoints but can only be used in one tour.  

• If a keypad start reader is used, then a system PIN code must be configured and linked to Guard Tour in the 
Pin Code programming screen (not cardholder screen). Additionally, a keypad reader must be configured for 
PIN Required “always” & PIN Mode as Information Only. 

• The tours must be created in the software. During this process, card readers or inputs are assigned to the 
tour; and the tour parameters and behavior rules are configured for the desired operation. 

• Tour Cards (credentials) must be enrolled into the System Galaxy software and given valid access 
privileges to the doors/readers on the tour. If a Tour Card does not have valid access at every checkpoint 
reader, the tour cannot be completed successfully. 

• The system expects the same card that starts the tour to be used at every checkpoint reader. The tour 
cannot be completed successfully if the cards are switched mid-tour. 

• Invalid access attempts are not reported to the Tour Event listview in the Guard Tour Status screen. 

• All checkpoints must be visited in the same order they are listed in the Tour Setup screen when a tour is 
set to operate in Sequential Mode.  

• Point intervals and point sequence are both enforced for Sequential Tours but not for Random Tours. 

• Max Tour Time and Max Start Interval timers apply to all tours (sequential and random) 

• The ‘checkpoint’ readers and inputs must be installed and configured properly (Note:  a reader that is 
already serving as a door or gate access can be used as both an access point and a guard tour point – or 
the checkpoint reader can be dedicated to the guard tour use.  

 
 



System Galaxy  Guard Tour Addendum  

Page 6 of 30 

 

GUARD TOUR 

The Guard Tour feature allows the SG Administrator to create and monitor Guard Tours (security routes) 
using checkpoints (tour points) that are made up of readers or input devices from the access control system.   
 

  
 A Guard Tour is a designated set of checkpoints (readers and inputs) that must 

be visited/activated in a specific order or time limit.  
  

 
 
 
Benefits of Using Guard Tour 

Guard Tours are useful at any facility that wants a traceable log/report providing proof of diligence that the 
safety/security officers are performing their inspections promptly and correctly. This could be implemented at 
malls, schools, public parks, banks, high-rise multi-tenant buildings, municipal buildings, court houses, 
detainment facilities, warehouses, or other factory/industry type facilities that perform safety or security 
checks. 

Guard Tours help ensure the consistency and compliance of security/safety officers: 

• provide clear performance expectations for the security team and safety officers 

• ensure that tours are performed in a consistent and timely manner  

• ensure that all tours are performed at the expected times each day 

• control which areas must be visited/inspected and in what order 

• ensure that designated checkpoints are not being missed or skipped within the facility 

• alert the security team to the point of trouble - for missed or late checkpoints and overdue or 
incomplete tours 

• monitor tours as they happen 

• pull historical reports on past tours 
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How Guard Tour Works  
 
A guard or security officer starts a tour, by swiping a Tour Card (with or without a PIN) at the start point 
reader. The guard proceeds to each checkpoint on the tour.  The guard must activate the reader or input at 
each point as he/she progresses until the tour is complete.   
 
Various Tour Timers are tracked by System Galaxy depending on which Tour Mode is configured. Point 
sequence is only enforced in Sequential Mode. 
 
System Galaxy reports the Tour Status and any violations, including points that were missed/late, or out of 
sequence to the Guard Tour Status screen. The system also logs any violations to the SG Alarm screen.   
   
 

Tour/Alarm Violations Mandatory Sequence Mode Random Order Mode 
Out of Sequence Tracks Point Sequence violations (not tracked) 

Interval to Points Tracks Point Interval Timer violations  (not tracked) 
Max Tour Time  Tracks Total Tour Time violations Tracks Total Tour Time violations 

Max Start Interval Tracks Time Elapsed between Starts Tracks Time Elapsed between Starts 
 
 

SG Console showing the monitoring screens in a split-window view 

 
 

SG Alarm screen 
(monitoring violations) 

Guard Tour Status screen 
(monitoring tours & violations) 
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Planning a Guard Tour 

This section helps System Administrators decide how the tour should work before creating the tour. 

1. Which reader will be the startpoint?  

• A startpoint must be a reader. This reader is used to initiate the tour every time it is run. 

• A startpoint reader must be a keypad if that start point will be used as the start point in 
multiple tours.   

2. How many checkpoints will be assigned to the tour and where should they be?  

• Additional checkpoints can be readers or inputs. These checkpoints should be strategically 
placed along the tour route that the security/safety officer will travel. 

• NOTICE: an input cannot be shared or assigned to multiple tours and cannot be used as a start 
point because it can be activated without presenting credentials (identity). 

3. Will any tours share a Start Point Reader? 

a. If each tour has its own start point, the tour can use a separate card reader;  

b. If any tours use the same start point reader, then a Keypad Reader must be used and the 
Keypad must be configured for Pin Mode. 

 

4. Which Tour Mode should be used –  

a. Can/should the checkpoints be visited in Random Order each time the tour runs? Then a 
Random tour is the chosen. 

b. Should the checkpoints be visited in a Mandatory Sequence and/or the time intervals between 
checkpoints be enforced/tracked? Then a Sequential Tour is chosen. 

5. How long should take to reach each checkpoint? [Interval to Reach Point]  

a. To enforce or track the point interval times, the tour must be in Sequential mode. 

6. How long should the entire tour take to run? [Max Tour Time] 

7. How often should the tour be performed (i.e. every 3, 6, 24 hours)?  [Max Start Interval] 

 

NOTICE: an input cannot be shared between tours, since the input cannot report the 
identity of the cardholder.   
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Setup Rules and Behavior of Tours 
 

The behavior of a tour is determined by which mode is chosen for the tour.  Also Maximum Tour Time and 
the Maximum Start Intervals affect tour behavior.  

Point Sequence and Point Interval Times only affect the Sequential tours.  

Other behavioral factors include whether the tour violations are configured to create alarm conditions in 
the system. If the system is configured to recognize tour violations as alarms, the system will log an alarm event to 
the SG Alarm Screen.  The Alarm screen will pop to the front if configured to do so.  See the section on How to 
Configure Guard Tour Alarms.  

 

About How ‘Tour Modes’ Work  

There are two Tour Modes available (Random and Sequential). You must assign a tour mode. 

  
 Configuring a tour for “Sequential Mode” means the system will track/enforce 

the exact order of the checkpoints, as well as the time intervals between tour 
points and max tour time.   

 Configuring a tour for “Random Mode” means the system will not track/enforce 
the sequence or the time intervals between checkpoints, but will enforce the max 
tour time.   
   

 

Random Order Tour Operation: If a tour is placed in "Random Order” Mode, the checkpoints can be visited (activated) 
in any sequence, regardless of how the points are listed in the Guard Tour Setup screen.  

The guard must visit every checkpoint before the maximum tour time expires. 

• A Random Tour is started by presenting a card (or PIN) to the Start Reader assigned to the tour. PIN mode 
is only needed if the same reader will be the start reader for multiple tours.   

• A Random Tour is ended by either when the guard has visited every reader in the tour – OR – when the 
max tour time expires - whichever happens first. Order & Intervals do not apply. 

• A Random Tour is “Completes Successfully” when a guard has visited every reader before the maximum 
tour time expires (i.e. no points are missed). 

• Every / All checkpoints must be activated, but can be visited in any sequence/order (i.e. randomly). 

• Both, the Maximum Tour Time and the Maximum Start Intervals apply to a random tour.  

• If the Max Tour Time and Max Start Interval timers are exceeded, the system will log the violation to the 
Tour Status screen and trigger an SG alarm event .   
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Mandatory Sequence (Sequential): In "Mandatory Sequence" Mode, the tour points must be visited (activated) in the 
same sequence as they are listed in the Guard Tour Setup screen. Also the point intervals and the Maximum Tour Time 
cannot be exceeded. 

The guard must visit each checkpoint before the point interval expires. The Maximum Tour Time as well as each 
Interval to Reach Next Point must not be exceeded. 

• A Sequential Tour is started by presenting a card (or PIN) to the Start Reader assigned to the tour. PIN 
mode is only needed if the same reader is a start reader for multiple tours.   

• A Sequential Tour is ended by either when the guard has visited every reader in the tour – OR – when the 
max tour time expires - whichever happens first. 

• The tour checkpoints must be visited in the sequence listed in the Tour Setup screen. An “out of 
sequence” event logs to the Tour screen and SG Alarm screen when the sequence is violated. 

• The Interval to Reach Next Point is only tracked/enforced for a sequential tour. A “late to point” event 
logs to the Tour screen and to the SG Alarm Screen when the interval is exceeded. 

• The Maximum Tour Time and the Maximum Start Intervals apply to a sequential of tour also.  Violating 
these timers will be logged to the Tour Status screen and the SG Alarm screen. 

• SG Alarm events can be filtered to/from the to trigger an SG alarm by setting an alarm priority (non-zero 
value) for them in the Guard Tour tab of the System Settings screen. 

 

 

 
SG Guard Tour Setup screen / Tour Mode droplist 
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About Adding a Start Point Reader to a Tour 
 
The start reader can be added manually or by placing the tour in LEARN MODE. In Learn Mode the 
system will automatically add the start reader to the tour list when a card is presented. 
 
The readers can be rearranged by using the up and down buttons to move the readers. 
 
If a start reader is used in more that one tour, then the reader must be a Keypad reader and must be 
configured for PIN MODE. 
 
 
 

  
 The “startpoint” is the first point listed in a tour – specifically in the Tour 

Point list of the Guard Tour Setup screen.    

 The start point must be a reader – i.e. cannot be an input;  
  

 
 
 

 
SG Guard Tour Setup screen / Adding a startpoint reader to Tour List 
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About Adding Checkpoints Manually vs. Learn Mode. 
 
The checkpoint (reader or input) can be added manually or by placing the tour in Learn Mode.  Either way, the 
points can be rearranged or deleted as needed.   

Using Learn Mode is a good way to determine the amount of time it actually takes for a guard to reach 
each point and to complete tour. The operator can manually change the point intervals and max tour 
time as needed.  

 

  
 Learn Mode is a feature that allows the system to capture/build the 

checkpoints by having a guard walk the tour route (real-time) and 
activate each point that should be added to the tour. The system also 
captures the time intervals between each point as it adds the point to 
the tour setup listview.    
  

 

When configuring a tour, the operator can place the tour in Learn Mode at any time.  This means the operator can 
capture the entire tour from start to finish in Learn Mode, or use Learn Mode to build part of the tour.  

The system automatically adds the point and the timer interval it took to reach the point to the tour list when the 
point is activated (either by presenting a card or by activating an input).  

Learn mode can be used to build a Random Order tour as well as a Sequential tour.  If building a Random 
tour, the point intervals are captured but will not be enforced when the tour is performed, since random 
tours can be run in any sequence.  The order of points and point intervals are only enforced in a 
Sequential tour. 

   
Click here to start Learn Mode. The 
system will capture the readers as a 
guard walks the tour route. The system 
will also capture the ‘point intervals’.  

Click here to add readers to the tour 
manually. You must configure the 
‘point intervals’ also. 
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About Tour Timers & Violations 
 
All tours apply/enforce Max Tour Time and Max Start Interval timers.  These tour timers will create status 
updates on the Guard Tour Status screen and on the SG Alarm screen when they are violated. 

Only the Sequential tours enforce the point sequence and point intervals. These tour timers will create status 
updates on the Guard Tour Status screen and on the SG Alarm screen when they are violated. 

NOTE: The SG Alarm Events can be filtered or suppressed tour alarms at any workstation by configuring the local 
client for alarm priorities in the Alarm Options tab of the System Settings screen, and then configuring a 
compatible value in the Guard Tour tab that causes the tour violations to either be suppressed or allowed in the 
local Alarm event screen. See more in the section about Configuring the Guard Tour Alarm Options. 

 

  
 The Maximum Tour Time (HH:MM:SS) is to the amount of time it should take to 

perform the tour. This timer starts when the start point is activated. Exceeding 
this timer will cause a late tour/incomplete tour event to be reported. An SG 
alarm can also be triggered if this timer is configured in the System 
Settings/Guard Tour tab. 

 The Maximum Tour Start Interval (HH:MM:SS) is to the amount of time that can 
elapse between the last start time and next start time for the specific tour. 
Exceeding this timer will cause an overdue tour start violation to be reported. 
An SG alarm can also be triggered if this timer is configured in the System 
Settings/Guard Tour tab. 

 A Point Interval - or Interval to Reach Point (MM:SS) is the amount of time that it 
should take the guard to reach/activate the each checkpoint. The time 
intervals for each point will vary based on the time/distance a guard must 
travel. Exceeding this timer will cause a late point violation to be reported. An 
SG alarm can also be triggered if this timer is configured in the System 
Settings/Guard Tour tab. This timer only affects Sequential tours. 

 An Out of Sequence violation will be reported if a checkpoint is skipped, missed or 
visited out of order from the sequence defined in the Tour Setup screen. An SG 
alarm can also be triggered if this option is configured in the System 
Settings/Guard Tour tab. This only affects Sequential tours. If a checkpoint is 
missed in a Random Tour the tour will violate its Max Tour Time (be reported 
as incomplete). 

  
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Registering for Guard Tour 

The Guard Tour feature must be enabled through the System Registration screen.  The registration code 
entered must be valid and based on the customer’s purchase order / maintenance agreement. 
  
You can check the System Registration settings by opening the Registration screen from the SG menu 
and choosing Configure > Options > Registration.   
 
The Guard Tour feature is located in the System-wide Features of the Registration screen.  If the Guard 
Tour checkbox has been enabled (checked), the system is registered for this option. 
 
 

 
 

Contact your authorized Galaxy Dealer if you need to register for the Guard Tour function. 
 
Once the system is registered for Guard Tour, then any master operator can –  

• open the Guard Tour Setup screen from any client/workstation to create tours 
• open the Guard Tour Status screen from the view menu to monitor tours. 
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Creating a Random Order Tour 

1. Open the Guard Tour Setup screen: from the SG menu Configure > Guard Tours.   

2. Click the [Add New] button  

3. Type a name for the tour in the [Tour Name] field.  

4. Set the [Tour Mode] droplist to “ Random Order”. 

5. Set the Maximum Tour Time (HH:MM:SS) – this will be the maximum amount of time allowed for the 
guard to complete the tour (i.e. visit all checkpoints).  

This timer calculates the time elapsed since the currently running tour started. 

6. Set the Maximum Start Interval (HH:MM:SS) – this will be the maximum amount of time that can elapse 
between tour starts.  

This timer calculates the time elapsed since the last time the tour started. 
 
For example, if you set this to 24:00:00 (24hrs) then the tour must start at the same time once a day.  If 
you ran the tour at 8:00am, then you must start the tour again by 8am on the next day.  If you set it to 
3:00:00 (3hrs), the tour must start every 3hrs.  
 
 

 
SG Guard Tour Setup screen / Random Order Mode 

 
 
 
 

~Continue programming on next page ~ 
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7. Add a point by choosing the desired reader from the [Add Reader] droplist. Follow these steps. 

a) Enter 00:00 in the [Interval to Reach Point] time (mm:ss)  

{A point interval can be zero for a start point and doesn’t count for checkpoints in a random tour} 
Note: System Galaxy does not track/enforce the point interval times or the sequence of points 
when a Random Order Tour is performed. Total Tour Time (max tour time) is enforced. 

b) Select the reader name* you want to assign to the point, from the [Reader] droplist (or input).  

{* IF you are adding a startpoint, you must select a reader. Other checkpoints can be a reader or 
input from the appropriate droplist. } 

c) Click the [Add to Tour] button beside the appropriate Reader droplist (or input). 

8. Add the additional checkpoints (Either add the points manually by using steps 7a, b, c; or use the "Learn 
Mode" to capture points - see the previous section on Learn Mode for details. Keep in mind, that if the 
tour runs in Random mode, the point sequence will not be enforced when the tour is performed).   

9. Click [Apply] button to save the tour.  
 

 
SG Guard Tour Setup screen / Adding Point Intervals and Points 

Creating a Sequential Tour 

10. Open the Guard Tour Setup screen: from the SG menu Configure > Guard Tours.   

a 

b c 
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11. Click the [Add New] button  

12. Type a name for the tour in the [Tour Name] field.  

13. Set the [Tour Mode] droplist to “Mandatory Sequence”. 

14. Set the Maximum Tour Time (HH:MM:SS) – this will be the maximum amount of time allowed for the 
guard to complete the tour (i.e. visit all checkpoints). This timer calculates the time elapsed since the 
currently running tour started. 

15. Set the Maximum Start Interval (HH:MM:SS) – this will be the maximum amount of time that can elapse 
between tour starts. The timer calculates the time elapsed since the last time the tour started. 
For example, if you set this to 24:00:00 (24hrs) then the tour must start at the same time once a day.  If 
you ran the tour at 8:00am, then you must start the tour again by 8am on the next day.  If you set it to 
3:00:00 (3hrs), the tour must start every 3hrs.  

16. Add a point by choosing the desired reader from the [Add Reader] droplist. Follow these steps. 

a) Enter 00:00 in the [Interval to Reach Point] time (mm:ss)  

{A point interval can be zero for a start point and doesn’t count for checkpoints in a random tour} 
Note: System Galaxy tracks/enforces the point interval times and sequence of points when a 
Sequential Tour is performed. Total Tour Time (max tour time) is also enforced. 

b) Select the reader name* you want to assign to the point, from the [Reader] droplist (or input).  

{* IF you are adding a startpoint, you must select a reader. Other checkpoints can be a reader or 
input from the appropriate droplist. } 

c) Click the [Add to Tour] button beside the appropriate Reader droplist (or input). 

17. Add the additional checkpoints (Either add the points manually by using steps 7a, b, c; or use the "Learn 
Mode" to capture points - see the previous section on Learn Mode for details. Keep in mind, that if the 
tour runs in Random mode, the point sequence will not be enforced when the tour is performed).   

18. To change the time interval to reach a point, first highlight the specific point in the listview, then enter 
the new time interval in the provided fields and click the [Update Interval] button. 

19. Click [Apply] button to save the tour.  

See the prior section on Creating a Random Order Tour for a screen shot. 
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Adding Checkpoints to an Existing Tour 
Tour points (readers, inputs) can be added manually in the Guard Tour Setup screen. 
 
To add a reader checkpoint, follow these steps:  

1. Select any reader from the [Add Reader to Tour] droplist. 

2. Set the minutes and seconds in the [Interval to Reach Point] timer fields: this is the maximum allowed 
time to reach this point from the start of the tour or previous checkpoint.  If the tour is in arbitrary mode, 
this time will be disregarded. 

3. Click the [Add To Tour] button to add the reader to the checkpoint list. 
 
To add an input device checkpoint, follow these steps:  

1. Select any input from the Add Reader to Tour drop-down list. 

2. Set the minutes and seconds in the [Interval to Reach Point] timer fields: this is the maximum allowed 
time to reach this point from the start of the tour or previous checkpoint.  If the tour is in random mode, 
this time will be disregarded. 

3. Click the [Add To Tour] button to add the input to the checkpoint list. 

 

 
SG Guard Tour Setup screen / Tour Point listview 

 

Use [Reader/Input] droplists  
and [Add to Tour] buttons to 
add points to the tour. 
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Using “Learn Mode” to Capture Tour Points & Intervals  

You can capture (add) checkpoints and point intervals on a tour by using ‘Learn Mode’.  Learn Mode is a good way 
to determine how long it should really take to reach each point and perform the entire tour.  

Learn Mode is available to Random Tours and Sequential Tours.  

• The system adds each reader (checkpoint)  to the [tour point] list-view as the officer walks the tour route 
and presents a valid access card to each reader that is to become a checkpoint.  

• The system records the amount of time it takes the officer reach the each point in the [Interval to Reach 
Next Point] field.    

• The tour begins recording (learning) when you click the [Learn Mode] button.  The system begins the "Start 
of Tour" from the moment you click the Learn Mode button.   

 

After the checkpoints & intervals have been captured in Learn Mode, an SG Operator can manually adjust the tour 
in the Guard Tour Setup screen: 

• change the order/sequence of the checkpoints  
• adjust the interval to reach the next point – as needed  

 

1. Open the Guard Tour Setup screen (Configure > Guard Tours) 

2. Either select an existing Tour Name and click the EDIT button (or add a new tour by clicking [Add] and 
configuring a Tour Name, Tour Mode, Max Tour Time and Max Start Interval). 

3. Click the [Learn Mode] button, to open the Card Finder window.   

4. Use the Card Finder to search/choose the access card that will be used to capture the points. 

5. Walk the desired tour route and present the chosen card at each reader (tour point / checkpoint).  
Remember to walk the tour at the pace you would expect the officer to do in reality in order to capture 
realistic tour point intervals – and have the guard handle any visual/physical inspections, stops & checks that 
are actually expected. For example, if the guard should physically check every padlock on a row of doors in 
an area, then don’t just walk by them; actually take the time to check them as is expected. 

 
Use the selected card at the reader points that will comprise the tour.  The points will be added as they are used.  
When all the readers have been added, the points can be edited manually (rearranged using the arrow buttons), 
and the intervals can be edited manually (using the Update Interval button).   
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Changing the Sequence of Checkpoints  
 

After tour checkpoints are added to the list of tour points, they can be rearranged using the UP/DOWN buttons.   
 

1. Select the desired Tour Name from the droplist and click EDIT button. 

2. Select  (highlight) the checkpoint (reader or input) in the list . 

3. Click the appropriate UP/DOWN button to move the checkpoint up or down in the list.   

4. Click Apply button to save your changes. 
 
 

 
SG Guard Tour Setup screen / Tour Point listview 

 

Use the [UP/ DOWN] buttons to change 
the order of points in the tour. 
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Deleting a Checkpoint  
 

The [X] button deletes a tour point. 
 

1. Select the desired Tour Name from the droplist and click EDIT button. 
2. Select (highlight) the checkpoint (reader or input) in the list . 
3. Click the [X] button to move the checkpoint up or down in the list.   
4. Click Apply button to save your changes. 

 

 
 
Changing the Point Interval Time  
 

The [Interval to Reach Point] time field is used to reach the next point, the [Update Interval] button. 
 

1. Select the desired Tour Name from the droplist and click EDIT button. 
2. Select (highlight) the checkpoint (reader or input) in the list. 
3. Click the [X] button to move the checkpoint up or down in the list.   
4. Click Apply button to save your changes. 
 

 

 
SG Guard Tour Setup screen / Tour Point listview 

 
 

Use the [X] buttons to change the order 
of points in the tour. 

Use the [Point Interval] fields and the 
[Update Interval} button to change the 
time to reach the next point in the tour. 
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Creating a Tour Card (Start Card or PIN Code) 

There are two ways to start a tour.   Each of these ways is described in the following sections. 

• present a valid card at the startpoint reader  
• enter a PIN code at a startpoint keypad  
 

NOTE: The card that is used to start the tour is expected to be used at each checkpoint reader in  the 
tour.  The card must have valid access (access privileges) to every checkpoint.  

 
IMPORTANT: IF a card doesn’t have valid access (access privileges) to any checkpoint on the tour, the 
tour will not count the card read as a valid tour activation.  This will result in a missed point at that 
reader and the point will remain “yellow” in the Status screen. The tour will be logged as 
incomplete/overdue when the max tour timer expires.  

 
 
Enrolling a Card for Guard Tour  
 
To create a Valid Access Card, you can enroll a new card or select an existing card record.   
 

1. Open the Cardholder screen by clicking the Cardholder toolbar button or by selecting from the menu  
Configure > Cards > Cardholders. 

2. Enter a name in the Last Name field  that indicates  the name of the guard or optionally the name 
“Tour”, or name of a specific tour/shift or other generic name that identifies how it will be used. 

3. (optional) Enter a name in the First Name field (if need to have more than one Tour Card for the same 
tour – you can distinguish specific guards or runs). 

4. Click the Card/Badge Settings tab 

5. Enroll the card code (setting the Technology droplist and adding the card code as appropriate). 

6. DO NOT enter a PIN here – the PIN Code for Guard Tour is covered in the next section. 

7. Select “Access Control” in the [Card Role] droplist. 

8. Click the [Edit Loops] button and double-click every loop name desired to move them to the 
Authorized Loops list. You must choose any loop that contains the readers that the Tour Card will 
need access to.  

9. Click OK to close the Loop Select window. 

10. In the [Authorized Loops] droplist, select a loop name 

11. In the [Select Access Group] droplist, you can choose the access group that provides the desired 
access privileges to the reader (or you can choose “unlimited” if the tour card should work all the 
time). See the Programming Chapters of this Guide that cover creating schedules and access groups for 
more information.  Also see the section Personal Doors if you want to add the readers that way. 

12. Repeat Steps 8 and 9 for each loop that you added in Step 7. 

13. Click Apply button to save the card 
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Configure a System PIN Code for Guard Tour 

To initiate (start) Guard Tours by PIN code, a PIN code must be configured in System Galaxy and linked to Guard 
Tour. That same PIN code must be used along with a valid card-read at the start point reader in order to begin the 
tour. 

To create a "Start Tour" PIN,  

1. Open the PIN Codes screen  Configure > Cards > PIN Codes.   

2. Click the [Add New] button,  

3. Enter any PIN up to 65,535 in the [PIN] field.  (must be numeric) 

4. Enter a name or identifying text for this code in the [Description] field.   

5. Then select a tour name from the [Start Guard Tour] droplist.   

6. Click Apply button to save. 
 

 
PIN Codes screen / Adding a Start Tour PIN 

Be sure to choose the 
correct Tour Name. 
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Configure a Keypad Reader as a Startpoint Reader (enable PIN Mode) 

To initiate (start) Guard Tours by PIN code, the startpoint Keypad reader must be configured for PIN Mode in the 
Reader Properties window.   

1. Open the Reader Properties screen for the Keypad (start reader) Configure > Hardware > Doors/Readers.   

2. Select the appropriate Loop / Controller. Then select the keypad reader from the Reader droplist.  

3. Click the [Edit] button, and select the Timing/Schedules tab. 

4. Set the [Pin Required Schedule] droplist to “**ALWAYS**”. 

5. Set the [PIN Mode] droplist to “Information Only”. 

6. Click Apply button to save. 
 
NOTE:  When a reader is set to PIN Required & Information Only, the keypad reader will the Guard Tour PIN numbers 
as a valid PIN only if it is preceded by a valid access card swipe.  However, if the card does not have valid access -OR- 
if no number is entered, the reader will not allow access or start the tour.   

NOTE: In the Event History window, when the PIN Code used was configured to be a ‘Start Guard Tour’ PIN Code, the 
report will display “Guard Tour” PIN column.  If the PIN Code used was configured to be a ‘Start Guard Tour’ PIN 
Code, the report will display the actual PIN number that was used in the PIN column.   
 

 
SG Reader Properties screen / Configuring PIN Mode 
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Monitoring Guard Tours  

The Guard Tour Status screen is the primary screen used to monitor a tour. The SG Alarm screen will display any 
alarm events (overdue tour, late point, point sequence, and tour start time violation). 
 
 
 
Viewing the Guard Tour Status 

The Guard Tour Status screen has several status lists that will be populated with the status and events that are 
related to the selected tour.   
 

NOTE: The card that is used to start the tour is expected to execute the tour. 

1. To monitor a tour, open the Guard Tour screen (from SG menu View > Guard Tour). 

2. Select the Tour Name tab to view the desired tour. 

3. Click the [Refresh Status] button ONLY if you want to clear/refresh the screen. 

4. Start a tour by presenting a valid card / entering the PIN code at the start point reader. 

a. The Tour Status list will show that the tour is “In Progress” 

b. The tour start and completion status will be logged to the top list 

c. The Tour Points will change from “yellow” to “green” as they are visited.  Red means missed. 

d. The valid access events will be logged to the Tour Events list as they occur. 

Note: the SG Alarm Event screen will display any alarm events that the Tour generates.  This screen can 
be programmed to POP to the front or the SG Monitoring Pane can be split by dragging and dropping the 
Guard Tour screen into a split pane. 
 

 

 
SG Alarm screen & Tour Status screen (monitoring shown in a split window) 
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Refreshing the Guard Tour Status screen 
 
There are two ways to refresh the screen: either update the screen while its open, or restart the screen. 
 

1. To restart/refresh the Guard Tour Status screen, close the Status screen and re-select it from the SG menu 
(i.e. View > Guard Tour). 

This will reset / clear the lists so you can start fresh. 

2. To update the screen with active tour data, click on the [Refresh Status] button. This will clear the Tour 
Event list and reset/refresh the Tour Points to ‘yellow’ waiting status. 

 

 

The [Refresh] button always displays 
regardless of which tour tab is chosen. 

Tour tab 
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Monitoring Tour Events and Alarms 

The status of a tour (whether it is in progress or not) is viewed in the Guard Tour window (View > Guard Tour).   

To see the status of a specific tour, select the Tour Tab just above the Tour Status window.   

 

 

Understanding the Tour Status screen 
At the top of the Tour Status screen is the Tour Summary listview - showing the following fields –   

 

Column Meaning of the Columns 

Tour Name The name of the Tour that is currently being Monitored 

Information The start and end status/condition of the tour. 

• Start On Time/ Started Late / Max Tour Start Interval Expired  

• Completed Successfully / Max Tour Time exceeded – points missed 

Date/ Time This is the date/time stamp of the start and end of the tour.  

 

 

SG Guard Tour Status screen / Tour Cycle listview 
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Understanding the Tour Status listview 
Beneath the Tour Name tab is the Tour Status  listview - showing the following fields –  

 

Column listed Information Field ( possible states /conditions of the fields ) 

Current Status “Waiting for Start”, “Tour in progress”, … 

Guard this is the Cardholder Last, First Name 

Start Time this is the date/time that the Tour Start reader was activated 

Start Status “Waiting for Start”, “Waiting Late”, “Started On Time”, … 

Finished Time this is the date/time that the last checkpoint was activated 

Finished Status “Completed Successfully”, “Time Expired – Missed Points”, … 

Total Tour Time this is the total time that elapsed from start to finish 

 

 

 

 

 

SG Guard Tour Status screen / Tour Status listview 

 

Use scroll bars to view status info. 

Choose the desired Tour tab. 
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Understanding the Tour Points listview 

Beneath the Tour Status listview is the Tour Points list - showing the following columns –  

 

Columns Listed Meaning of the Columns 

Sequence # Col Lists the points in the numerical sequence they are listed in the tour.  

• Green = on time 

• Yellow = Pending/waiting 

• Red = overdue (late to start) 

Clicking the Refresh button will reset all points to yellow/pending.  

The startpoint will go ‘red’ if the max tour start interval is exceeded. 

Tour Point 
Col 

this is the Door/Reader or Input Name 

Status Col This shows the date/time the reader or input was activated 

Comments This shows the Status (On Time, Late by 00:05:13 minutes:seconds, …) 

Count This indicates whether the point has been activated (which is especially useful 
for a Random Order Tour since the point sequence is not enforced).  

 0 =point not visited; 1 = point visited 

 
 
 
 

 
SG Guard Tour Status screen / Tour Points listview 

 

Point Sequence is only enforced for a Sequential Tour. 

You must REFRESH the screen to  
see newly added points. 
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Understanding the Tour Event listview 

Beneath the Tour Points listview is the Tour Events list - showing the following columns –  

 

Columns Listed Meaning of the Columns 

Date/Time Col Date/Time stamp of the tour card events, logging real-time as the guard 
makes the rounds and activates tour readers.  

Clicking the Refresh button clear this list.  

Device/Point 
Col 

this is the Door/Reader or Input Name 

Event Col This shows the Valid Access granted at each point 

User This shows the Last and First Name of the Tour Card or access card used at the 
tour point. 

 
 
 
 
 
 
 
 
 
 
 

 
SG Guard Tour Status screen / Tour Events listview 

 
 
 

Invalid Access events are not shown 
on this log/view. See the normal Event 
window for invalid access attempts. 
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